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Course Information 
Complete for all courses
	Course Prefix
	Course Number
	Course Title
	Textbook

	CMPS	3420	Database Systems	ISBN13 978-0-13-608620-8


Type of Course Conversion
Select Type of Course Conversion:   Changed  
	Course Type
	Definition
	Information Needed

	New
	A new course is proposed. The rationale, place in the curriculum, and resource implications are contained in the accompanying proposal summary. This form contains the proposed course number, title, default textbook, catalog description, and PeopleSoft entries.
	Textbook
Syllabus 
Catalog Description
PS Catalog

	Unchanged
	The course has been offered in the last five years and will be converted from a 5-quarter-unit course into 3-semester unit course with no other changes in the catalog, PeopleSoft system, or course articulation.
	Textbook
Syllabus

	Changed
	The course has been offered in the last five years and will be converted into a 3-semester unit course (or closest semester equivalent) with the changes indicated in this document. Unless otherwise indicated, there will be no other changes in the catalog, PeopleSoft system, or course articulation.
	Textbook
Syllabus 
Updates To (if applicable)
Catalog Description
PS Catalog

	Elective Inactivation
	The course is an elective course, will be inactivated, and will no longer be printed in the catalog.  The course can be reactivated if it will be consistently taught. Since the course is not required in any program, there will be no need to make student accommodations for this category.   
	 No additional information required

	Required Inactivation
	The course was a required course that will not be offered in the semester system.  If an outside department requires the course, that department/program chair will need to approve the accommodation.  
Describe Accommodation:  List whether students will be accommodated by a waiver of that requirement, a substitution, or some other action.
 [Enter Accomodation Here]
	Accommodation


Catalog Description and Course Syllabus
	IMPORTANT INSTRUCTIONS  

	· To turn on “Track Changes” locate Review > Track Changes in the top menu and then make your proposed changes to the catalog description.   Need Help ?  See Tip Sheet
· To attach the Course Syllabus, locate Insert > Object > Attach as File and browse to locate and upload your syllabus.  Need Help ?  See Tip Sheet
· To submit the course, follow these steps:
1. Save the file using the Course Name and Number as the filename.  Example:  MAT 320
2. When done, attach the file to an email and send the email to  nsmecourses@share.calstate.edu


Catalog Description
If changes to the catalog description are proposed, enter the existing description and make the proposed changes with tracking on to show the changes. Existing course descriptions are found here.
	Catalog Description
	CMPS 3420 Database Systems (54) 
Basic issues in data modeling, database application software design and implementation. File organizations, relational model, relational database management systems, and query languages are addressed in detail. Two-tier architecture, three-tier architecture and development tools are covered. Each week lecture meets for 200 150 minutes and lab meets for 150 minutes. Prerequisites: CMPS 2952020 with a grade of C- or better and CMPS 2120.


Attach Course Syllabus
Attach the master syllabus or sample syllabus to this template by placing your cursor after this paragraph, then locating the Insert Tab in the top ribbon and find Insert > Object > Attach as File.  

[bookmark: _MON_1470045871]> 
Changes to PeopleSoft Catalog  (only required for new courses)
You can skip this section for most course modifications that require no changes to prerequisites or modes of instruction.  If changes are necessary, please enter the changes below. Use only the primary component unless the course involves two modes of instruction (combined lecture/lab course)
	Course Components
	Component Units
	CS#
	Grading Basis*
	Pre-requisites
	Corequisites
	Action or Changes Required

	Primary Course Component
	3
	C04-Discussion	N=Graded	[bookmark: _GoBack]CMPS 2020 with a grade of C- or better and CMPS 2120
	
	

	Secondary Course Component (optional)
	1
	C16-Sci Lab	[Grading Basis (Secondary)]	
	
	


* RP Grading Basis requires approval from the Academic Programs office.
[bookmark: _Approval_Cycle]Review and Approval Cycle
Please select one value from the following drop-down field that represents the review/approval cycle.   Each value triggers a workflow notification to start review by the department, curriculum committee, dean, and final approval.
Select Review and Approval Cycle:   Curriculum Committee Review
Reviewers
Please enter the name of who is conducting the review for each step of the review cycle.
	Review Cycle
	Name 
	Date Complete
	Comments / Revision Requests

	Department 
	Melissa Danforth	8/8/2014	

	Curriculum Committee 
	Melissa Danforth	[CC Review Date]	

	Q2S Exceptions Committee
	[Q2S CCC Chair]	[Q2S CCC Review Date]	This Review Level only applies to exceptions and interschool programs.

	Dean  (Final Approval}
	[Dean Approver]	[Dean Approval Date]	
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Catalog Description



CMPS 3420 Database Systems (4) 

Basic issues in data modeling, database application software design and implementation. File organizations, relational model, relational database management systems, and query languages are addressed in detail. Two-tier architecture, three-tier architecture and development tools are covered. Each week lecture meets for 150 minutes and lab meets for 150 minutes. Prerequisite: CMPS 2020 and CMPS 2950.



Prerequisites by Topic

Programming skills in one of main programming languages, data structures and algorithm (CMPS 2020). The set theory, set operations, and first-order logic of CMPS 2950 are required.



Units and Contact Time

[bookmark: _GoBack]4 semester units. 3 units lecture (150 minutes), 1 unit lab (150 minutes).



Type

Required for CS



Required Textbook



Fundamentals of Database Systems, 6th Ed.by Elmasri & Navathe, published by Addison Wesley  ISBN 978-0-13-608620-8 



Recommended Textbook and Other Supplemental Materials



· Oracle 8/9/10, The complete reference (reference)

· Any Oracle SQL and Oracle PL/SQL will be useful.

· Any books on Microsoft Studio will will be helpful

· Any book on C# and ASP will be good.



 Coordinator(s)

Huaqing Wang



Student Learning Outcomes

ACM/IEEE Body of Knowledge Topics:

· Information models and systems (IM1): History and motivation for information systems; information storage and retrieval; information management applications; information capture and representation; analysis and indexing; search, retrieval, linking, navigation; integrity, scalability, efficiency, and effectiveness

· Database systems(IM2): History and motivation for database systems; components of database systems; DBMS functions; database architecture and data independence

· Data modeling (IM3): Data modeling; conceptual models; object-oriented model; relational data model

· Relational databases (IM4 & IM6): Mapping conceptual schema to a relational schema; Entity and referential integrity; Relational algebra and relational calculusl; Functional dependency and Normal forms.

· Database query languages (IM5): Overview of database languages; SQL; 4th-generation environments; database connectivities (JDBC, ODBC) † ; stored procedures †



 †Graphics user-interface design & programming (HC5 & HC6): client-server and three-tire architectures design and implementation .



ABET Outcome Coverage



3b. An ability to analyze a problem, and identify and deﬁne the computing requirements and

speciﬁcations appropriate to its solution.

3c. An ability to design, implement and evaluate a computer-based system, process, component,

or program to meet desired needs.

3f. An ability to communicate eﬀectively with a range of audiences.

3h. Recognition of the need for and an ability to engage in continuing professional development.

3i. An ability to use current techniques, skills, and tools necessary for computing practice.

3j. An ability to apply mathematical foundations, algorithmic principles, and computer science

theory in the modeling and design of computer-based systems in a way that demonstrates

comprehension of the tradeoﬀs involved in design choices.

3k. An ability to apply design and development principles in the construction of software systems

of varying complexity.



Lecture Topics and Rough Schedule



Chapter 7 Data Modeling using Entity-Relationship 9ER) Model

Chapter 8 The Enhanced Entity-Relationship (EER) Model

Chapter 10 Practical Database Design Methodology and Use of UML Diagrams

Chapter 1 Databases and Database Users,

Chapter 2  Database System Concepts and Architectures

Chapter 3 The relational Data Model and Relational Database Constraints

Chapter 9 Translate ER/EER Database to Relational Database 

Chapter 6 Relational tuple and domain relational calculus 

Chapter 4 Basic SQL

Chapter 5 More SQL: Complex Queries, Triggers, Views, and Schema Modification

Chapter 15 Basics of Functional Dependencies and Normalizations for Relational Databases



Materials Added :  Case Studies

1. Oracle: Interactive SQL, Embedded SQL, Oracle PL/SQL, and  Stored Procedures and triggers 

(Reference to chapters 3 and 4)

             2. Graphic User Interface, JDBC, C# (students learn C# or Java before and during class by themselves).



Week 1, 2, 3:

· Lectures discuss Chapter 7, 8 and 10. 

· Students will form a team or work individually to identity a business or organization that as a need for information system software.

· Each individual or team will present the business/organization, and sub-area which needs information system.

· Team/individual will work on concept database design, and document the targeted database and conceptual database design or Entity-Relational Database.



Week 4, 5: 

· Lecture on chapter 1 and 2. Database system and database management systems, their components and functionalities.

· Team/individual presents their conceptual database (Entity-Relationship Model) to class, and class will give suggestions.



Week 6, 7, 8, 9, 10:  

· Lectures chapters 3, 9, 6, 4, and 5 on relational model, three theoretical query languages (relational algebra (RA, tuple-calculus (TRC) and domain- calculus(DRC), and conversion from conceptual databases to logical (relational) databases. Design and implementation of queries in RA, TRC and DRC.

· Students will convert their E-R databases to relational database, design queries and answer the queries in RA, DRC, TRC and document all the works.



Week 11, 12: 

· Lecture on SQL language, Oracle SQL/Plus, PL/SQL, Java Database Connectivity (JDBC), and Open Database connectivity (ODBC).

· Student will convert their logical database (relational) database to physical database (on Oracle DBMS). Convert theoretical queries in to SQL queries, Create views and stored procedures, triggers and etc.

Week 13: 

· Chapter 15. Lecture on relational normal forms: its definitions and problems of un-normalized relations.

· Students check their relations against normal form, and make changes to their relations.



Week 14:  

· Lecture on Graphical User Information (GUI) design and implementation, GUI components and layout, event and event handling.

· Students design one or two GUI interfaces in the language they choose as final phase of this course, and present the final project to the class.

Week 15:

       -	Class project presentations and written report due



Design Content Description



      Each individual or team will work on a database system for designed for a business/organization. The design will be divided into the following phases:

· Information collection and conceptual database design ( Entity-relational Model will be used)

· Logical database design  (Relational Model will be used)

· Physical database resign (Oracle database management system will be used)

· Graphical User Interface (GUI) will be design and implemented ( choose any IDE and language)

· Three oral presentations and one written report with coding are required.





Prepared By

Huaqing Wang on [date]

Approval

Approved by CEE/CS Department on [date] 
Effective [term]


